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How to use the MRP or Dissertation template 
David A. Welch 
February 2023 

These templates are designed to be compliant with the University of Waterloo’s formatting guidelines 
for MRPs and doctoral dissertations. They include all of the sections that you are likely to need, in the 
correct order, with correct page numbering. These sections include a Table of Contents (ToC), a List of 
Figures, a List of Tables, a List of Acronyms, main body sections, and a bibliography (“References”) 
section. You may find that you need additional sections (for example, one or more Appendices). If so, 
you can simply add these to the document you created based on the template. I will explain how to do 
this correctly below. There may also be sections you do not need (for example, a List of Tables or a List 
of Acronyms). If so, you can simply delete them. For the most part, all you will need to do with these 
templates is substitute placeholder text with text of your own. But to use these templates most 
efficiently, it is important to understand how Microsoft Word works and how to customize the 
document that you create based on one of these templates. 

Styles 

Everything in Word is style-driven. Do not treat Word as a software equivalent of a typewriter; this will 
result in a formatting mess when you make changes to the document down the road. Generally 
speaking, your finished document should never use tab characters, two or more consecutive spaces, or 
two or more consecutive carriage returns (what word calls a Paragraph Mark, ¶, inserted by hitting the 
Enter key). You are doing things wrong If, when you click the ¶ symbol in the Paragraph section of the 
Home tab on the ribbon — which reveals formatting codes —, you see something like this: 
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You are also doing something wrong if you click anywhere in your document and discover, either via the 
Style Inspector or by seeing which style is highlighted in the Styles section of the Home tab on the 
ribbon, that everything is in the Normal style. You want to control all aspects of formatting, spacing, 
widow/orphan control, keeping lines together, etc., via styles, and you should ensure that every part of 
your document that requires specific formatting has an appropriate style designed to handle it properly. 
That is what I have done with these templates. They come pre-populated with properly-formatted Word 
styles properly applied where they need to be. 

You will, of course, find a Normal style in the template that you are using. Word always requires one. 
But it is good practice never to use it. Use appropriately-tailored styles everywhere instead. 

Among the styles in these templates that you will use often are the following: 

Heading – Non-ToC This is for a heading that you do not want included in the ToC (for example, 
the Author’s Declaration, the Abstract, and the Acknowledgements). If for 
some reason you do want any of these sections included in the ToC, change 
this style to the Heading 1 style. 

Heading 1 This is the style for a major heading. It will be included in the ToC as a level-1 
head. 

Heading 2 This is the style for a subheading. It will be included in the ToC as a level-2 
head. 

Heading 3 This is the style for a sub-subheading. It will be included in the ToC as a level-3 
head. (If you need four or more levels of headings, you can use the Heading 4 
style, etc. though you will need to modify it to match the formatting of the rest 
of the document in terms of font, font size, bold, italic, indentation, etc.) 

Body Text This will be the most commonly used style in your document. The 
overwhelming majority of your text will use this style. It is properly formatted 
for line spacing and paragraph spacing and includes a first line indent. 

Body Text no ind The is the Body Text style with a first line that is not indented. You will 
occasionally want to use this — for example, in your abstract, or for text that 
follows a block quote that itself does not terminate a paragraph. 

Block Quote This style sets off from the rest of a paragraph a long quotation both 
horizontally and vertically. Note that for block quotations you do not need 
(and should not use) quotation marks. 

Caption This style should appear below a table or figure. Word will number the table or 
figure automatically and the text in the caption will appear automatically in 
your List of Figures or List of Tables. 

Bibliography This style is for the works you cite in your References section at the end of the 
document. It is properly formatted for hanging indent. 

 

These templates include other styles that you will probably not need to bother with, such as styles for 
individual entries in your ToC, List of Figures, or List of Tables. You can modify these styles if you wish. 
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Indeed, you can modify any style whatsoever. Please just ensure that, if you do so (for example, because 
you dislike the font I have assigned to a style), you still have a professional-looking document at the end 
of the day. 

There are two ways to modify a style. One is to modify a paragraph in your document that is formatted 
in the style you want to change and, with the cursor anywhere in that paragraph, go to the highlighted 
style on the Home tab, right-click, and choose “Update [style] to Match Selection.” The other is to right-
click on the style first and choose “Modify.” This will bring up a dialogue box that gives you full control 
over all formatting options for the style. Most commonly, you will want to click on the Format button on 
the bottom-left of the dialogue box, click on Font first (if you want to change the font in any way), and 
then click on Paragraph second. Clicking on paragraph will bring up another dialogue box with three 
tabs: (1) Indents and Spacing; (2) Line and Page Breaks; and (3) Asian Typography (you will probably not 
need to bother with this last one). The spacing controls on the first tab are particularly important; these 
control how much vertical white space there will be between the current paragraph and the previous 
and/or next paragraph. Where you would be tempted to use multiple carriage returns (¶), adjust these 
values instead. On the Line and Page Breaks tab, keep “Widow/Orphan control” checked (so that you 
don’t have single lines of a paragraph all alone at the top or bottom of a page), and, for any Heading 
style, make sure you have “Keep with next” checked so that you don’t have stray headings at the 
bottom of a page. If at any point in your document you want to ensure that some number of lines are 
kept together on a page, check “Keep lines together.” 

Sections 

As I mentioned at the beginning, the document that you create from the template will be divided into 
sections already. The title page, dedication, abstract, acknowledgements, ToC, list of figures, list of 
tables, list of acronyms, and bibliography all have their own sections. The main body of the document I 
have also divided into separate sections (one per “chapter”), although this is not strictly necessary; you 
could use hard page breaks instead (Ctrl-Enter). But there is no real downside to having them all as 
individual sections. 

The point of dividing your document into sections is so that you can control formatting for that part of 
the work independently. So, for example, your title page should be centred both vertically and 
horizontally, and it should have no page number. Some of the front matter, such as the dedication, 
abstract, and acknowledgements, need not have a page number, either. The ToC, list of figures, list of 
tables, and list of acronyms all have page numbers in Roman numerals, counting from the abstract as p. i 
(even though there is no page number on the abstract page). The main body and all subsequent sections 
of your document will be numbered continuously from 1 in Arabic numerals. 

If you want to delete a section, simply go to the beginning of its heading, select everything from there to 
the beginning of the next section that you want to keep, and hit “Delete.” If you want to add a section, 
place the cursor at the end of the text of the section immediately preceding the one you want to create 
and then, on the Layout tab, select Breaks | Section breaks | Next page. 

Note that page numbers are stored in footers. Word’s default is to continue numbering from (and retain 
the format of) the previous section’s footer. If you want to restart the numbers or change the page 
numbers from Arabic to Roman or vice versa, you should double-click in the footer, click on the page 
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number, right-click, and choose Format Page Numbers. You should also deselect “Link to Previous” in 
the Navigation section of the Header & Footer tab. With luck, however, you should never need to do 
this. 

Figures and Tables 

In the templates, I have included one sample figure and one sample table. You will notice that each one 
has a caption attached to the bottom. You will also notice that the figure (or table) and caption are both 
contained within a text box (a species of what Word calls a “shape”). The purpose of this is to make it 
easier to place the figure or table where you want it on the page (usually the top) and have text flow 
around it smoothly. If you don’t place a figure or table in a text box and just have it run inline with the 
body text, you may find that Word is forced to move it to the next page to keep it together, leaving an 
enormous ugly white space on the previous page. 

My strong advice is to use these sample text boxes to place your own figures and tables where you want 
them in the document. It is trivially easy to replace the content: just select my sample, delete it, insert 
your own, then edit the caption accordingly. The text box container is formatted with no border so that 
it looks clean, but you can click anywhere on the border, right click, choose “Cut,” and then move it to 
wherever you like (or to a new blank document temporarily while you tweak it before inserting it in your 
main document again). 

When you click on the text box frame, you will also see a “Layout Options” menu symbol appear at the 
upper-right. Click on this, make sure “Fix position on page” is selected, then click on “See more…” If you 
want the figure or table to appear at the top of a page, make sure that, on the Position tab, you have 
selected (1) Absolute position 0” to the right of Margin and (2) Absolute position 0” below Margin. It is a 
good idea to make sure that, on the Text Wrapping tab, you choose “Top and bottom.” 

Troubleshooting 

Like any complicated software program, Word can be buggy. You are likely to have particular problems 
with counter fields (page numbers, figure numbers, and table numbers). My strong advice is only to 
worry about these when you are doing final tidy-up. If you keep fixing issues as you find them, you are 
likely to discover that they will just crop up again later. 

If you have the document formatted exactly as you want it and you find that the figures and tables are 
not numbered properly (as will certainly be the case if you have just pasted multiple copies of my 
samples where you want your own), go through them one-by-one, click on the actual figure or table 
number, and hit F9. This will update the field to the correct number sequentially. Then go to your ToC, 
select “Update Table,” and choose “Update entire table.” If you already have the headings in the ToC as 
you like them, you can instead choose simply “Update page numbers only” instead. Finally, do the same 
for your List of Figures and/or List of Tables. If you have both kinds of lists in your document, you may 
find that Word wants to put all of your figure and table captions in both lists. This is a bug. Let it do what 
it wants and then manually delete whatever does not belong in those lists. 
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Miscellaneous hints 

• Back up your document often! It is a good idea to set up automatic backup. 
• Use a different filename for every version of your document so that if you have an issue with 

one, you can go back to a recent version without having lost too much work. 
• Try to avoid using the “Automatically update” feature in the style formatting dialogue box. This 

will have unintended consequences elsewhere in your document where you use the same style. 
• Finally, feel free to ask me if you have any questions or encounter any difficulties. 

Happy writing! 
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